DOLI Elektronik GmbH

Corporate name: DOLI Elektronik GmbH
Headquarters: Adi-Maislinger-Straße 7, 81373 München, Germany
  ☏ (+49)-089-20 243-0
  Fax (+49)-089-20 243 243
  e-mail info@doli.de

Production: Ulmer Straße 34, 89584 Ehingen, Germany
  ☏ (+49)-07391-3421
  Fax (+49)-07391-5680
  e-mail ehi@doli.de

Sales: Mühlstr. 26, 55271 Stadecken-Elsheim, Germany
  ☏ (+49)-06130-944250
  Fax (+49)-06130-944251
  e-mail sales@doli.de

Internet: www.doli.de
        www.flexometer.com
# Table of Contents

## 1 INTRODUCTION

1.1 Safety Hints ......................................................................................................... 6
  1.1.1 General Safety Hints ..................................................................................... 6
    1.1.1.1 Warning Signs and Hints ........................................................................ 6
    1.1.1.2 Demands on personnel .......................................................................... 6
  1.1.2 CE-Conformity, Directions and Standards ..................................................... 7
  1.1.3 Specified normal Operation ........................................................................... 7

1.2 Description of the Standard Flexometer ............................................................... 9
  1.2.1 Temperature chamber .................................................................................... 10
  1.2.2 Handling arm - sample silos ......................................................................... 10
  1.2.3 Height measurement of the sample ................................................................. 10
  1.2.4 Preheating the sample ................................................................................... 10

1.3 Specifications ....................................................................................................... 11
  1.3.1 Compressed-air supply .................................................................................. 11
  1.3.2 Power supply ................................................................................................ 11
  1.3.3 Dimensions .................................................................................................... 12
  1.3.4 Delivery data .................................................................................................. 12
  1.3.5 Environmental demands .............................................................................. 12
  1.3.6 Sample ........................................................................................................... 12

1.4 Installation of the On-line-Help System ................................................................. 13

## 2 OPERATION

2.1 Preparation of the Flexometer ............................................................................... 14

2.2 Program .................................................................................................................. 15
  2.2.1 General ........................................................................................................... 15
    2.2.1.1 Software - Start ...................................................................................... 15
    2.2.1.2 File Management ................................................................................... 16
  2.2.2 Control ............................................................................................................ 17
    2.2.2.1 Control with the Keyboard .................................................................... 17
    2.2.2.2 Control with Function fields .................................................................. 18
    2.2.2.3 Control with Pop-Up-Menu .................................................................. 19
    2.2.2.4 Control with Main menu ....................................................................... 19
  2.2.3 Flexometer Settings ......................................................................................... 21
    2.2.3.1 Hardware ................................................................................................ 21
    2.2.3.2 Chamber .................................................................................................. 23
    2.2.3.3 Files ........................................................................................................ 24
    2.2.3.4 Filename ................................................................................................ 25
    2.2.3.5 Language / Print ..................................................................................... 26
    2.2.3.6 Display .................................................................................................... 27
    2.2.3.7 Graphic .................................................................................................... 28
    2.2.3.8 EDC ......................................................................................................... 29
    2.2.3.9 Security ................................................................................................... 30
    2.2.3.10 Special .................................................................................................. 32
    2.2.3.11 Calibration Check ................................................................................. 33
  2.2.4 Parameter ......................................................................................................... 36
    2.2.4.1 Input of test parameters ......................................................................... 36
  2.2.5 Tools ................................................................................................................ 39
    2.2.5.1 Debug-Messages .................................................................................... 39
    2.2.5.2 Bit - Inputs .............................................................................................. 39
    2.2.5.3 Manual Control ..................................................................................... 40
  2.2.6 Offline - Edit graphics ..................................................................................... 41
  2.2.7 Offline - Settings ............................................................................................. 42
2.2.8 Unfinished test data..............................................................................................................43
2.3 Test..............................................................................................................................................44
  2.3.1 General Test Description......................................................................................................44
  2.3.2 Flextest ......................................................................................................................................45
  2.3.3 Blowout Test Deformation/Temperature ..............................................................................46
2.4 Results.........................................................................................................................................47
  2.4.1 Single results ........................................................................................................................47
  2.4.2 Result Graphic......................................................................................................................47
  2.4.3 Printouts................................................................................................................................48
  2.4.4 Comparing results - Multichart..............................................................................................48
  2.4.5 Calibration Results................................................................................................................50
  2.4.6 Results – Explanation...........................................................................................................52
3 MAINTENANCE..................................................................................................................................53
  3.1 Draining of the Compressed-air System......................................................................................53
  3.2 Cleaning the Stations...................................................................................................................53
  3.3 Changing the lower holder...........................................................................................................54
  3.4 Changing the puncture needle.....................................................................................................54
4 ERRORS.............................................................................................................................................55
  4.1 Failure in the sensor technology.................................................................................................55
    4.1.1 Example: Controlling the limit switches for the puncture needle.................................55
1 INTRODUCTION

(Version 4.0.0.2 Release: 18.04.2008)

Dear customer, thank you for choosing the Standard Compression Flexometer from DOLI Elektronik GmbH. This manual will help you to get familiar with the instrument soon and it will help you to be able to answer questions and solve problems, which may arrive during the operation.

- You will get a description of your new instrument.
- You will get an operation and maintenance manual.
- You will get a description of the Flexometer test procedure.

© 2004 DOLI Elektronik GmbH. All rights reserved.
1.1 Safety Hints

1.1.1 General Safety Hints

Read this manual carefully before starting with the installation and operation of the Flexometer. False handling of the instrument can cause severe damage to persons and property. It is essential to adhere to the technical directions and connection conditions from the name plate and documentations.

1.1.1.1 Warning Signs and Hints

This manual contains several symbols, that will allow you to find your way more easily. Furthermore, the manual contains warning signs adverting to possibly dangerous situations. These warning signs may be found on the instrument, too. It is essential to adhere to the warning signs and the related hints:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️</td>
<td>Safety Instructions:</td>
</tr>
<tr>
<td></td>
<td>In order to avoid interruptions in the work flow as well as damages to man and machine, follow the safety instructions at all cost.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Safety Instructions: Danger by electricity and its effects</td>
</tr>
<tr>
<td></td>
<td>In order to avoid interruptions in the work flow as well as damages to man and machine, follow the safety instructions at all cost.</td>
</tr>
<tr>
<td>🚦</td>
<td>Job/work instructions:</td>
</tr>
<tr>
<td></td>
<td>Instructive part of the document with precise work instructions</td>
</tr>
<tr>
<td></td>
<td>Here you are asked to do something.</td>
</tr>
<tr>
<td>📚</td>
<td>Information:</td>
</tr>
<tr>
<td></td>
<td>General information and descriptions of working procedures, etc.</td>
</tr>
<tr>
<td>🚫</td>
<td>Note:</td>
</tr>
<tr>
<td></td>
<td>Important note for the operation, the function or for the working procedures.</td>
</tr>
<tr>
<td>🌟</td>
<td>Tip:</td>
</tr>
<tr>
<td></td>
<td>Gives tips for easy handling of the Flexometer.</td>
</tr>
</tbody>
</table>

1.1.1.2 Demands on personnel

⚠️ Attention! Only qualified personnel are allowed to perform transport, mounting, installation, start-up, operation or maintenance.

Qualified personnel are people being well acquainted with transport, mounting, installation, start-up, operation or maintenance. These people must be adequately qualified for their occupations. In detail:

- **Transport:** Personnel skilled in treating componentries being susceptible to electrical discharge, only!
- **Installation:** Personnel with electro-technical apprenticeship, only!
- **Start-up:** Personnel with wide-ranged skills in the fields of electrotechnics and/or drive engineering, only!
- **The qualified personnel must know and adhere to the following standards and directions:**
  - IEC 364 respectively CENELEC HD 384 or DIN VDE 0100
  - National accident prevention directives or VBG 4
1. INTRODUCTION

Attention! The EDC appliances do contain components being susceptible to electrical discharge. These components may be damaged by incorrect treatment. Avoid the contact with highly insulating material (synthetic fibres, synthetic foils etc.)

Attention! Do not open the EDC appliances! Keep all coverings closed during operation. There is danger of dead or severe damage to persons or property.

Attention! Draw the mains plug before opening the covering of the EDCs. There is danger of dead or severe damage to persons or property.

Attention! Never disconnect any electrical connection especially at the EDC, while the instrument is still energized. In bad cases, electric arcs may emerge and damage persons or property.

Attention! After having drawn the mains plug, wait at least two minutes before touching potentially live components (e.g. contacts, thread bolts) or disconnecting any electrical connection. After disconnection of the supply voltage, capacitors may bear dangerous voltages for up to two minutes. For your safety, it is recommended to measure the voltage in the link and wait, until it has fallen below 40V.

1.1.2 CE-Conformity, Directions and Standards


Low Voltage Directive (73/23/EEC): The harmonized standards of the series prEN 50178 in connection with EN 60204 are used for our appliances.

EMC-Directive (89/336/EEC) and (2004/108/EC): Under observance of the installation instructions of this documentation, we herewith declare the meeting of the objectives of the EMC Law (EMCG) for facilities and instruments with the following standards:


In this documentation, you will find instructions for the EMC-compatible installation, such as shielding, grounding, manipulation of plugs and laying of wires.


The EC directive (2002/95/EC) is used for our appliances, also.

Regarding the safety of machines, the following standards are met:

DIN EN 292, DIN EN 294 part 1...4, DIN prEN 954 part 1, DIN EN 418 of 01.93, DIN EN 349 of 08.90, DIN VDE 0160 of 05.88, DIN EN 50081 part 2, DIN prEN 50082 part 2, DIN 51233 of 11.91, VW 11.062 of 10.87

Observe national rules for prevention of accidents or VBG-4.

1.1.3 Specified normal Operation

The Flexometer has been designed to carry out tests of rubber samples following the standard ISO 4666/3.
1.1. Safety Hints

Operate the Flexometer with the allowed power supply systems and under the allowed environmental conditions, only! Adhere to the instructions given in this manual.

A start-up of the instrument (i.e. the specified normal operation) is allowed for compliance with the EMC directive (89/336/EEC), only. The appliances meet the requirements of the EC Low Voltage Directive (73/23/EEC).

⚠️ Attention! Inappropriate handling of the Flexometer may affect the functionality of the instrument or cause severe damage to persons or property.
1.2 Description of the Standard Flexometer

A Flexometer is used to measure the permanent deformation and increase in temperature of cylindrical rubber samples, following the standards ISO 4666/3, ASTM D 623 and BS 903, part A50.

For this purpose, the sample is loaded between two holders, applied with constant load and cyclically upset along its axis.

Load is applied via a balance beam equipped with a weight on both sides. The sample is loaded with the difference value of the two weights.

In the course of the test the sample fatigues so that the balance beam tends to leave its horizontal position. The position of the balance beam is monitored with a LVDT and readjusted in a horizontal position.

The following values are measured during the test:
1.2. Description of the Standard Flexometer

1. Test time via the internal processor clock
2. Temperature of the lower holder on which the sample rests
3. Deformation via the incremental rotary encoder

Deformation is measured in percent (%): 100% corresponds to 2.5mm (1 inch). One rotation of the micrometer screw corresponds to a deformation of 2.5%.

The room and holder temperatures as well as the sample deformation under dynamic load are measured before and after the test. When the sample is inserted into the test area, the static deformation of the sample is measured. Immediately after termination of the test, a puncture needle injects into the sample, measuring the center temperature inside the sample.

While the test is in progress the curves of the
1. deformation and
2. holder temperature

will be displayed in relation to the test time and the digitalized measured values are stored on hard disk. After the test has been completed, these graphics and a protocol are sent to a printer (optionally).

1.2.1 Temperature chamber

Optionally, it is possible to execute the entire test sequence in a temperature chamber with selectable temperature.

1.2.2 Handling arm - sample silos

Optionally, it is possible to insert and remove the samples automatically with the aid of a handling arm.

1.2.3 Height measurement of the sample

In the height measurement station, the height of the sample will be measured before and after the test. The measurement of the deformation will then be adapted to the actual sample height. I.e. the sample height measured before the test (initial height) corresponds to 100%. The sample will be measured again directly after the test and maybe after one hour of cooling time. Therefore, at least two cooling stations are available in addition to the height measurement station. The cooling time is selectable. The initial height of the sample must be within the limits of:

24.75mm < 25mm < 25.25mm

Otherwise the sample is placed in the garbage container and the test is rejected.

1.2.4 Preheating the sample

The sample can be preheated in the temperature chamber over a selectable period of time. Preheating and testing of the samples in the automatic test sequence may overlap.
1.3 Specifications

1.3.1 Compressed-air supply

Supply: 6 bar, 1l/min

Inner diameter of the hose of the Flexometer: 6mm

⚠️ **Attention!** The compressed-air must be clean and free of water or oil, otherwise, a severe damage of the Flexometer may be caused!

1.3.2 Power supply

Power supply: TN-S 230VAC, 50Hz, 1kW

For Canada and USA: TN-S 200...210VAC, 60Hz, 1kW

Voltage regulator: Capacity of 1500VA (if necessary)

---

**Fig. 3: Connection diagram Standard Flexometer.**

**Fig. 4: Connection diagram Standard Flexometer. Specifications for Canada and USA.**
1.3. Specifications

1.3.3 Dimensions

Fig. 5: Dimensions of the Standard Flexometer. a) top view, b) front view

1.3.4 Delivery data

Packing: wooden box on a euro pallet
Size: (incl. Packing and pallet) W 120cm, D 80cm, H 193cm
Weight: net 391kg, incl. packing 441kg

1.3.5 Environmental demands

Temperature: +5°C to +40°C
Humidity: max. 50% at +40°C
max. 90% at +20°C
Frost: The instrument must not be exposed to frost!
If possible, operate the instrument in an air conditioned lab.

1.3.6 Sample

Material: rubber
Dimensions: Height 25mm ±0.25mm; Diameter 17.8mm ±0.15mm
Hardness: max. 82 Shore A
1.4 Installation of the On-line-Help System

For using the On-line Help System you need the Microsoft Internet Explorer 4.0 or higher. On PCs with older versions as Microsoft Windows 95 you must install the HTML Help Update (HHUPD.EXE). You can find this program on the install CD.

Start this program (Start → Run → A:\HHUPD.EXE).

In the internet, you can find the latest version of HTML Help Update and other language versions under http://msdn2.microsoft.com
2.1 Preparation of the Flexometer

Turn the main switch of the Flexometer to the ON-Position.

![Fig. 6: Lower front of the Flexometer. 1=main switch](image1)

![Fig. 7: Main switch in ON-Position](image2)

Turn the compressed-air valve (see Fig. 8, No 3) in flow-through position (longitudinal to the hose). The valve limits the system pressure to 6 bars (indicated on pressure gauge in the front). The pressure gauge in the rear shows the needed pressure for the height measurement station (HMS). The pressure is preset to 2 bars.

![Fig. 8: Pneumatic control. 1=Pressure gauge system pressure (6bar); 2=pressure gauge MS (2bar), 3=compressed-air valve](image3)
2. OPERATION

2.2 Program

2.2.1 General

2.2.1.1 Software - Start

Double click on the Desktop-Icon **Flexometer** to start the "DOLI Flexometer" Program. The **Main Menu** window will open.

![Main Menu Window](image)

**Fig. 9: Main menu window:** 1=data grid with sample data to be tested, 2=graphic section 3=test time, 4=temperature lower holder, 5=deformation of the sample, 6=function field Drive On, 7=function field Results ([Calibration])

On the left side, one can find the so called data grid for the management of all sample data to be tested. An exact description of the data grid will follow in chapter **File Management**.

On the right side, there are the on-line-graphic and the values for testing time, holder temperature and deformation.

Click on function field **Drive On** to activate the Flexometer control (in case of a missing of this field, activate the item **New Reference Drive** via menu **File** → **command Settings** → **dialog Hardware**).

![Drive ON](image)

**Fig. 10: Function field Drive On.**

→ In the Flexometer, the lower holder will now drive to its programmed reference position (for the full automatic version this applies to the thickness gauge of the height measurement station and the handling arm, also).
2.2. Program

2.2.1.2 File Management

Data are managed with the help of the so called data grid:

The grid on the left side of the Main Menu window is used to manage the sample data of untested sample. Data of sample already tested can be found in the window Tested Samples (function field Results in the Main Menu window, see chapter Results, also).

<table>
<thead>
<tr>
<th>Station</th>
<th>Compound</th>
<th>Date</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silo 1</td>
<td>1abc</td>
<td>22.9.2004 12:30:15</td>
<td>abc_001.00</td>
</tr>
<tr>
<td>Silo 1</td>
<td>1abc</td>
<td>22.9.2004 12:29:03</td>
<td>Pet_abc.00</td>
</tr>
<tr>
<td>Silo 1</td>
<td>1b</td>
<td>22.9.2004 12:28:21</td>
<td>001</td>
</tr>
<tr>
<td>Silo 1</td>
<td>1cc</td>
<td>22.9.2004 12:27:14</td>
<td>Pet1_01_c.00</td>
</tr>
<tr>
<td>Silo 1</td>
<td>1b</td>
<td>22.9.2004 12:26:40</td>
<td>Pet_01_b.00</td>
</tr>
</tbody>
</table>

The standard sorting in this data grid is the date (where the newest test file is located on top). This sorting can be modified at any time through a click onto the column header. (However, this varied sorting is only retained until the program is terminated).

Looking at the entries in the column Station, you can see, which samples are to be tested. (Station = Manual, Silo 1, Silo 2) and which have been tested already (Station = Gauges, PHeatS, Holder...). The data of the actual test is represented red in the data grid (the parameters of this file can not be modified!).

The following stations are possible:

1. Manual (manual Flexometer)
2. Silo 1 respectively Silo 2 (automatic Flexometer fetches samples from this silo)
3. Gauges (Height measurement station)
4. PHeatS (Preheat station)
5. Holder (Test area)
6. Cool 1 - Cool 5 (Cooling station 1 - Cooling station 5)

After test end is reached the tested data will be transferred into the window Tested Samples.
2. OPERATION

2.2.2 Control

2.2.2.1 Control with the Keyboard

In addition to the mouse, some functions of the program can be served with the keyboard as well.

List 1: Key functions in the program.

In general:

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>Function inside the program</th>
</tr>
</thead>
<tbody>
<tr>
<td>F10</td>
<td>Activates /deactivates the keyboard control</td>
</tr>
<tr>
<td>Arrow keys ← ↑ ↓ →</td>
<td>Using the arrow keys, a change between the function keys of the main menu line as well as a call-up of the submenus is possible.</td>
</tr>
<tr>
<td>Enter</td>
<td>Calls up the selected function.</td>
</tr>
</tbody>
</table>

Inside the open window:

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>Function inside the program</th>
</tr>
</thead>
<tbody>
<tr>
<td>F10 and arrow keys ↑ or ↓</td>
<td>Opens a submenu to control that window.</td>
</tr>
<tr>
<td>Arrow keys ↑ or ↓</td>
<td>Change between the functions.</td>
</tr>
<tr>
<td>Enter</td>
<td>Calls up the selected function.</td>
</tr>
</tbody>
</table>

With the function „Move“:

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>Function inside the program</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys ← ↑ ↓ →</td>
<td>Moves the window</td>
</tr>
<tr>
<td>Enter</td>
<td>Closes the function</td>
</tr>
</tbody>
</table>
2.2. Program

2.2.2.2 Control with Function fields

General File Function fields

- Submenu to control the program window
- New (Creates a new parameter file)
- Delete (Deletes a parameter file)
- Edit (Edits the actual marked parameter file)

Note: Only possible for already tested samples!

Results

- Results. Opens the window Tested Samples.

Multichart

- Opens the window Multichart. In this window, the results of up to five samples can directly be compared.

Test

- Start (Starts the next Flexometer-test = oldest untested parameter file)
- Pause (stops a testing series after the end of the actually running test.)

Note: Only for automatic Flexometer!

- Stop (cancel at once, the running test will not be finished and the series will be cancelled!)

Flexometer

- Activates the Flexometer control
- Opens the results of the instrument calibration.
2. OPERATION

2.2.2.3 Control with Pop-Up-Menu

Some commands as in chapter Control with Function fields can be found in the pop-up menu of the data grid. The pop-up-menu can be started with a click of the right mouse button.

**Pop-Up-Menu for untested parameter files:**

- New (New parameter data)
- Delete (Delete parameter data)
- Write (Edit parameter data)
- Pause (stops a testing series after the end of the actually running test.)

*Note: Only for automatic Flexometer!*

2.2.2.4 Control with Main menu

The Main menu can be controlled with the mouse as well as with the keyboard (see chapter Control with the Keyboard). The following menus will appear:

**File**

- New (New parameter data)
- Settings (Opens the window Flexometer Options for defining hardware properties, security, settings also.)
- Copy archive (copies the results archive to the wanted position in the database)
- Exit (Exit program)

**Edit**

- Delete (Deletes a tested parameter data)
- Write (Edit parameter data)

**Flexometer**

- Machine (incl. submenu)
- Chamber (incl. submenu)
- Calibration
- Calibration (Results)
- Manual control (opens the window Manual Control; see chapter Tools, also.)

The submenu Machine contains the following functions:
2.2. Program

!! Note: This window is for supervisors and service, only!!

2. Show I/O (opens the window Bit-Inputs; see chapter Tools, also)

The submenu Chamber contains the following functions:

3. Preheat (manual input of the preheating temperature)
4. Off (shuts off the temperature chamber control)

This menu is active only with a temperature chamber existing and entered in the system (see also chapter Flexometer-Settings → Hardware)

---

Service

- Power On (Only for EHC 3)
- Power Off (EDC)
- Messages (Debug-windows)

---

Information

- Settings (the Flexometer settings will be done in this window).

!! Note: This dialog is for supervisors and service, only!

- Contents & Index (Calls up the Online-Help program)
- Legend (opens the window Legend)
- About... (general information)

The submenu Legend explains the colour code of the sample data.
2. OPERATION

2.2.3 Flexometer Settings

Use the path File → Settings (incl. security check) to open the window Flexometer-Options.
It is divided into 10 submenus. These dialogs are for entering hardware characteristics, security settings etc.

![Flexometer-Options window]

**Note:** Each change of the options needs to be followed by a new program start!!

2.2.3.1 Hardware

**Options**

Here, the hardware configuration of the Flexometer must be set:

**Customer-ID:** Field for customized names (no effect on the test)

**Holder cooling time:** Here, insert the wished holder cooling time.

**Tip:** Keeping a definite cooling time at the end of the test (normally 5 minutes) will prevent the next sample from an unintended warm up by the lower platen (which may still be warm from the passed test).

**TDC Motor Delay:** In order to avoid inaccuracies in the position of the lower holder caused by hardware reasons, it is necessary to delay the stop of the TDC-motor.

**Note:** This value is preset by the DOLI-Service and must not be changed!

**Manual Flexometer:** Define, whether the Flexometer is a manual one (activate this field) or a fully automated one (no activation). Activation will load the possible hardware options for the fully automated Flexometer.

**Silo 2:** Activate in case of the existence of a second Silo.

**Chamber:** Having a temperature chamber, this option must be activated.
2.2. Program

Preheat station: Activate in case of the existence of a second Silo

Gauge- and 2 cooling stations: Activate in case of the existence of a height measurement station and two cooling stations.

3 Cooling stations: Activate in case of the existence of the block of 3 cooling stations.

New reference drive: When activated, the function field Drive On will appear in the Main Menu window.

Balance beam tolerance

Warning: The program gives a warning, when the position of the balance beam exceeds this value.

Limit: The Flexometer stops at this deviation.

Sample height

This function block is for entering the permissible variations in sample height. This results in a rejection of samples whose heights being outside of these tolerances.
2. OPERATION

2.2.3.2 Chamber

Note: These settings are done by the DOLI service and must not be changed!

ComPort for the temperature chamber

It denotes the serial interface for the communication between the temperature chamber and the PC.

The data entered below are adapted to the Flexometer and must not be changed.

Flexometer - Options

ComPort for chamber:

- Com 1
- Com 2
- Com 3
- Com 4
- Com 5
- Com 6
- Com 7
- Com 8

Temperature coefficient for heating: 30 sec/°C
Temperature coefficient for cooling: 110 sec/°C
Max. permissible temperature deviation: 2 °C
Monitoring time for temperature deviation: 50 sec
2.2.3.3 Files

Data directory

The path leading to the storage directory for sample data has to be entered here. (In this directory, the subdirectory **Handled** for tested samples will be created automatically.)

File format

Only the standard format is available (file is stored in ASCII format with approx. 1000 data records).

Grid order

This function can be used to change the order of the data grid in the **Main Menu** window. Just click on the column headline and move it with the arrows.
2. OPERATION

2.2.3.4 Filename

Up to 3 fields can be chosen to compose the name of the result file (ASCII-Format) out of.

Activating the option **Unlock file name for input** enables the user to freely define the file name in the **Main Menu** window.
2.2. Program

2.2.3.5 Language / Print

Language

The Display language as well as the File language can be changed. The Display language on one hand represents the language of the Flexometer software. All windows and printouts will appear in the chosen language.

The File language on the other hand, determines the language of the data records. All standard data will be stored in the chosen file language.

The following languages are available:

1. German
2. English

Print

The function block Print is used to define the print format of the results.

Print graphic: Activation makes it possible to print a graphic after test end in general. This option can be individualized for each sample in the window Parameter (see chapter Parameter). However, if this option is not activated in this window, it will be locked in the window Parameter, also!

Print protocol: Activation makes it possible to print a protocol after test end in general. This option can be individualized for each sample in the window Parameter (see chapter Parameter). However, if this option is not activated in this window, it will be locked in the window Parameter, also!

Landscape: horizontal print

Portrait: vertical print
2. OPERATION

2.2.3.6 Display

Parameter names

This submenu offers the possibility to change the names of single program parameters.
2.2. Program

2.2.3.7 Graphic

Time scale

There are two different scaling types: Fixed Scale and Variable Scale. Having the Fixed Scale, no further settings are needed. The scale depends on the actual test time. With the Variable Scale, the user is free to choose scaling according to his needs (possible units: hours, minutes, seconds).

Scale for deformation and holder temp.

Activation of Enable scale options for User offers the possibility to rescale the online-graphic per right mouse-click.

The following options define the look of the graphic:
Grids for the single axes, beginning and end of the scalings.
The settings chosen in this submenu will automatically be taken as base for a new parameter file (see chapter Parameter).

Standard: This function field returns all settings to the preset standard values.

Backcolor for Online-Graphic

Here, it is possible to change the background colour for the online-graphic.
2. OPERATION

2.2.3.8 EDC

Note: These settings are made by the DOLI-Service and must not be changed!

ComPort

This function block shows the serial interface for the EDC controlling the temperature chamber and the balance beam control.

Baudrate

The Baudrate is preset to 115,200.

ComPort for Handling arm

This function block shows the serial interface for the EDC controlling the handling arm.

Baudrate for Handling arm

The Baudrate is preset to 115,200.
2.2.3.9 Security

Change password

Activating the function field Change password opens a window, enabling the user to define or change a password (no password preset).

Formula Generator

Activating the function field Result – Parameters opens a window, enabling the user to create formulas in order to receive further results.

Before defining a new password, the old one has to be entered!
This window enables you to define up to four formulas in order to get individual results. These results will be seen on the result printouts.
2.2. Program

2.2.3.10 Special

**Machine Information**

These function fields do open windows for entering information about the test or the instrument for the user.

**Calibration-Check**

This software function helps to supervise the testing accuracy of the Flexometer.

It offers the possibility to regularly test calibration samples (daily, weekly...), the results of which can be compared to each other giving information about the testing behaviour of the instrument over a longer period of time.

For more information, see chapter Calibration Check.
2. OPERATION

2.2.3.11 Calibration Check

In the dialog Special, section Calibration Check, activate the function field Settings.

The following window will appear:

This software function helps to supervise the testing accuracy of the Flexometer. It offers the possibility to regularly test calibration samples (daily, weekly...), the results of which can be compared to each other giving information about the testing behaviour of the instrument over a longer period of time.

Calibration-Check

Activating this function results in the test of calibration samples under the following conditions.

1. Calibration-Check before every test:

If this function is activated, the Flexometer will test a calibration sample each time the function field Start (in the Main Menu window) is activated.

2. Advice for Calibration-Check after _ days:

(only with condition 1 not being active) This function is for defining the period of time after which the software requests the operator to do a calibration test (e.g. 2 - the request will come every two days).

3. Automatic Stop after Calibration?

With this condition being activated, the Flexometer will stop automatically after a calibration test.

Data Directory

Here, define the path for storing the calibration data file.

Separator for calibration results

The calibration results are stored on standard format with separators (see chapter Files). For a data export to another format, e.g. an EXCEL file, it is necessary to know what kind of separators have been used.

Tip: Chosen once, it is recommended to not change this setting anymore!
2.2. Program

Further on, the software will not be able to recognize a sign as separator, which is not currently defined in that place. Changing this setting after having stored a file with another separator will result in a disability to read this file (the setting has to be changed back to the old separator, then the file can be read again).

**Count of values showing in the graphic** __

Define the number of samples, which are to be compared with each other. The youngest files will be used. Entering 0 means all files will be compared.

**Calibration Parameters**

This function field opens the following window:

![Calibration Parameter Window](image)

The dialog **Parameter** is used to enter the sample parameters (see section Edit the parameters for further explanations).
The dialog **Result-graphic** is used to closer define the display of the calibration results (see chapter [Calibration Results](#)).

<table>
<thead>
<tr>
<th>Active</th>
<th>Parameter</th>
<th>Autoscale</th>
<th>Axis</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Initial gauge</td>
<td></td>
<td>24.0</td>
<td>26.0</td>
</tr>
<tr>
<td></td>
<td>Final gauge hot</td>
<td></td>
<td>24.0</td>
<td>26.0</td>
</tr>
<tr>
<td></td>
<td>Final gauge cold</td>
<td></td>
<td>24.0</td>
<td>26.0</td>
</tr>
<tr>
<td></td>
<td>Inner temperature</td>
<td></td>
<td>100.0</td>
<td>200.0</td>
</tr>
<tr>
<td></td>
<td>Room temp. start</td>
<td></td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>Floors temp. end</td>
<td></td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>Contact temp. start</td>
<td></td>
<td>90.0</td>
<td>110.0</td>
</tr>
<tr>
<td></td>
<td>Contact temp. end</td>
<td></td>
<td>120.0</td>
<td>130.0</td>
</tr>
<tr>
<td></td>
<td>Delta T</td>
<td></td>
<td>25.0</td>
<td>35.0</td>
</tr>
<tr>
<td></td>
<td>Delta T 25</td>
<td></td>
<td>25.0</td>
<td>35.0</td>
</tr>
<tr>
<td></td>
<td>Creep</td>
<td></td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>Fatigue life</td>
<td></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Permanent set cold</td>
<td></td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>Permanent set hot</td>
<td></td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>Permanent set 1 hrs.</td>
<td></td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>Static compression</td>
<td></td>
<td>-20.0</td>
<td>-10.0</td>
</tr>
<tr>
<td></td>
<td>Initial flexing compression</td>
<td></td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>Final flexing compression</td>
<td></td>
<td>-13.0</td>
<td>-5.0</td>
</tr>
</tbody>
</table>

- **Active**: Define, whether this parameter should be compared or not (the line will be released for input).
- **Parameter**: Designation of the parameter.
- **Autoscale**: Automatic scaling of the results graphic (the axes cannot be scaled manually anymore).
- **Axis**: Manual scaling of the x- and y-axis of the graphic (not active, when **Autoscale** is active).
- **Limit**: Define minimum and maximum limits for this parameter. In the results graphic, this limits will be shown as coloured belt, hence it can easily bee seen, whether a sample is within the given parameters.
2.2. Program

2.2.4 Parameter

2.2.4.1 Input of test parameters

Activating the icon **New** or choosing **File → New** (from the menu line) will open the window **Parameter**.

The parameter file, which has been edited at last, will automatically be taken as base for the new file.

If a change of already existing data (not tested yet) is necessary, the window **Parameter Change** can be opened as follows: Click on the file to be changed → click on the function field **Edit** or use **Main Menu line → Edit → Edit**.
2. OPERATION

Silo

This field shows the silo, the samples are to be taken out of. Having more than one silo, e.g. with a fully automated Flexometer, it is possible to choose a silo. But for a manual Flexometer, this field is automatically set to Manual.

Testing time

Input of the testing time in hours and minutes (max. possible: 999 hours and 59 minutes)

Cooling time

Input of the cooling time of ready tested samples in hours and minutes (max. possible: 99 hours and 59 minutes). Only possible with the option cooling station being selected in the window Flexometer-Options → Hardware (see previous chapter, also).

Chamber temp.

Input of the temperature for the temperature chamber. Only possible with the option temperature chamber being selected in the window Flexometer-Options → Hardware (see previous chapter, also). An entry of 0°C means no preheat of the sample before the test. However, with this entry, the preheat time should be set to 0 also, otherwise the handling arm will insert the sample into the preheat station.

Preheat time

Input of the preheat time in hours and minutes (max. possible: 99 hours and 59 minutes). Only possible with the options temperature chamber and preheat station being selected in the window Flexometer-Options → Hardware (see previous chapter, also). See also parameter Chamber temp.!!

Max. deformation
2.2. Program

Input of the maximum deformation in percent. The input must be between -50% and 0%. For reasons of hardware, a deformation higher than -55% is not possible. It would definitely damage the instrument.

Filename

Input of the filename for this parameter file. In case of an activation of the automatic name composition (Flexometer-Options → Filename), the software automatically enters the name (composed out of up to three parameter fields; see previous chapter, also).

Test procedure

This is the field to choose the wished test type. Possible test types are:

- **Flextest**: standard Flexometer test
- **Blowout deformation**
- **Blowout temperature**

For descriptions, see chapter Test.

Blowout factor

This field is relevant only for Blowout tests (see chapter Test).

Stroke, Load

These fields are pure comment fields without any influence to the test. (Having activated the automatic name composition, the file name will be composed out of the contents of the chosen parameter fields; see previous chapter, also.)

Print Graphic / Print Protocol

If these options have been released in the window Flexometer-Options → Hardware (see previous chapter, also), it will be possible here to individualize them for each parameter file.

Sample height

This field shows the entries already made in Flexometer-Options → Hardware (see previous chapter, also). In case of the existence of a height measurement station, the software enters the detected height into the first field and deactivates it.

Scale for axis

This option has already been defined in Flexometer-Options → Graphic (see previous chapter, also). However, the scalings can be changed due to the users’ experiences. (Recommendations for standard sample: Deformation 10% to -50%, holder temperature 50°C to 150°C). For means of graphics comparability, it is recommended to keep the chosen scalings for all tests.

Program to Comment 4

These fields are pure comment fields without any influence to the test. (Having activated the automatic name composition, the file name will be composed out of the contents of the chosen parameter fields; see previous chapter, also.)

Number of samples

Input the number of samples that are to be tested with these parameters. This option is possible for the creation of the first parameter file, only. Up to 100 copies of this file can be made. Just the filenames differ in the extensions (e.g. 123_ABC_XYZ.001 and 123_ABC_XYZ.100).
2. OPERATION

2.2.5 Tools

2.2.5.1 Debug-Messages

The Debug-Messages window opens via menu: EDC → Messages.

These messages help to precise states and to recognize possible errors more easily. These debug messages are not only shown in this window but also stored in a LOG file on fixed disk.

This window can also be called-up over the keyboard: STRG + M

2.2.5.2 Bit - Inputs

The window Bit-Inputs opens via menu Flexometer → Machine → Show I/O

In this dialog the bit inputs are represented. Also you can supervise the room temperature, the chamber temperature, the holder temperature, the needle temperature the eccentric speed and the balance beam.

This window can be opened with the key code: STRG + I
2.2. Program

2.2.5.3 Manual Control

Note: This part of the program is only for the DOLI-Service and for supervisors for testing individual parts of the Flexometer!

The Manual Control window is used for testing the hardware functionality, only. Therefore, this dialog is protected with a password. Depending on hardware settings in Flexometer-Options, specific function keys are locked or unlocked.

The user is able to look at the individual temperatures, at the eccentric speed, at the position of the balance beam via the dialog Bit-Inputs (Flexometer → Machine → show I/O).

This dialog can also be opened with the keyboard: STRG + S
2.2.6 Offline - Edit graphics

It is possible to edit graphics from already tested samples offline. You can open these graphics as follows:

1. Click on the function field Results (Archiv) in the Main Menu window. The window Tested Samples will open (see chapter Results, also).

2. Mark the result to be edited (by clicking on it or use the function field Open to search a file in your database) and click on the function field Graphic.

The following window appears on the screen:

The title line of this window shows the name of the file.

Furthermore, there are the following processing options:
2.2. Program

1. **Zoom** (move a frame around the desired field having the left mouse button pressed and then release the mouse button)

2. **Stop Zoom** (with pressed right mouse button move a frame from the right lower corner to the left upper corner and then release the mouse button)

3. **Scroll** (move the cursor with pressed right mouse button)

Calls-up a different setting dialog.
For detailed information see chapter Offline-Settings.
Visible or invisible gridlines for every individual axis

Printing of the currently selected off-line graphic.

Preview of the currently selected off-line graphic.

Arrows
browses between the results

Help
opens the Online Help

Exit
closes the graphic

2.2.7 **Offline - Settings**
The following dialog for the offline settings is available:

**Input possibilities:**

**Time**

Min (Minimum) 
Max (Maximum) 
Time unit 

Unit depends on selected time unit

**Deformation**

Min 
Max 
Increment 

Unit depends on selected time unit

**Holder temp.**

Min 
Max 
Increment 

Unit depends on selected time unit

**Deformation**

[Diagram of the dialog box for offline settings]
2. OPERATION

Min (Minimum) Unit in %
Max (Maximum) Unit in %
Increment (steps of axis scaling) Unit in %

**Holder temperature**

Min (Minimum) Unit in °C
Max (Maximum) Unit in °C
Increment (steps of axis scaling) Unit in °C

**Backcolor**

At this point, the background colour of the off-line graphic can be modified.

**Function field Standard**

Using the function field Standard, the default values can be read in!

**2.2.8 Unfinished test data**

Unfinished test files are the result of uncontrolled program breaks, which, on the other hand, may be the results of e.g. power failures. Therefore, the currently tested file is copied into a specific subdirectory of the given data directory (Test). In case of this sample having been tested correctly, the file will be deleted from the subdirectory Test and copied into the subdirectory Handle. This subdirectory contains tested files and such, which have been aborted in a controlled manner.

If an uncontrolled program crash occurs during an experiment, the file remains in the subdirectory Test. During the next start of program, the window Unfinished data shows all files, that are in the subdirectory Test. Now it is possible to store these files in the subdirectory Handle or delete them.
2.3 Test

2.3.1 General Test Description

A Flexometer is used to measure the permanent deformation and increase in temperature of cylindrical rubber samples. For this purpose, a sample is loaded between two holders applying it with a constant load. Then the sample is cyclically upset along its axis.

During the test course, the following values will be measured:

1. Test time
2. Contact temperature at the lower holder
3. Deformation of the sample
4. Prestress/preload

The curves

1. Contact temperature at the lower holder
2. Deformation of the sample

in relation to the test time will be displayed in real time.

An incremental encoder measures the deformation in percent (%) of the initial height $h_0$ of the sample, whereas 100% correspond to a change in height of 25mm. Immediately after the termination of the test (and if needed one hour after the test) a puncture needle injects into the sample, measuring the centre temperature of the same. After the test, the measurement data can be printed.

The following sections explain different test types.
2. OPERATION

2.3.2 Flextest

Test course with all possible hardware options:

1. Handling arm fetches sample from the silo/one of the silos

2. Insertion of sample into the height measurement station and measuring of the height (with option height measurement station only) - if necessary, rejection of sample

3. Insertion of sample into the preheat station and preheat of the sample (with option preheat station only)

4. Insertion of sample into the test area. Dynamic test, permanent detection of temperature at the lower holder and of deformation (displays and graphic at the main-menu window). Test end happens at the end of the given test time, at exceeding of the maximum allowed deformation or at abortion by the user.

5. Detection of the center temperature of the sample by the puncture needle. (Upper holder moves to the upper dead center, puncture needle punctures into the center of the sample, measures the temperature and comes out again. The software stores the detected temperature maximum as center temperature.)

6. Insertion of sample into the height measurement station and measuring of height; calculation of deformation out of the height (with option height measurement station only)

7. Insertion of sample into the cooling station and cooling for the given time (with option cooling station only)

8. Once again: Insertion of sample into the height measurement station and measuring of height; calculation of deformation out of the height (with option height measurement station only)

9. Sample is moved to the garbage bin.
2.3. Test

2.3.3 Blowout Test Deformation/Temperature

During the Blowout Test, the sample will be impinged with enough energy to cause a gasification of different components of the rubber compound inside the sample. The event of the escape of gas out of the sample is called Blowout.

The software uses the acceleration graph for recognizing the Blowout. This curve represents the first differentiation of the deformation- and/or the temperature graph:

![Graph showing Blowout test](image)

Fig. 11: Course Blowout test (draft).

After a response time of 20 seconds the software measures the tolerance band (=\(\text{Delta}\)) of the graph for a period of 10 seconds and normalizes its width to the value 1.

The Blowout causes a strong change of acceleration. Therefore, the graph obviously deviates from Delta. At the moment, this deviation reaches or exceeds factor 3 (this factor is an empirical value for standard samples) (\(+/\Delta x \text{ Factor}\)), a Blowout will be recognized and the test stops.
2. OPERATION

2.4 Results

2.4.1 Single results

The function field **Results** opens the window **Tested samples**. The left part shows the data records of the tested samples, whereas the right part shows the graphs (after clicking once on the record). Double clicking on a record opens the **Results** window, showing an overview of all results for this sample.

![Fig. 12: Window Tested Samples (see Legend for the colour code).](image1)

![Fig. 13: Window Results.](image2)

2.4.2 Result Graphic

Clicking on the file signal opens the window **Parameter** showing an overview of all parameters for that sample.
2.4. Results

The function field **Graphic** opens the Offline-Graphic for the sample. The program offers the possibility to edit the graphic offline (see section **Offline**, also).

![Offline Graphic](image1)

**Fig. 14: Offline Graphic.**

### 2.4.3 Printouts

Results can be printed as protocol (vertical) or as graphic (vertical or horizontal). The print-command is active in every result window.

![Result printouts](image2)

*Fig. 15: Result printouts. a) Protocol b) Graphic*

### 2.4.4 Comparing results - Multichart
The new function Multichart offers the possibility to directly compare the graphics of up to five samples. Function field **Multichart (Archive)** opens the window. Pressing keys **Ctrl. + Shift** and parallely clicking on single records will cause their graphics to show up in the graphics section in different colours at the same time.

Fig. 16: Window Multichart. Five samples have been chosen.

Fig. 17: Graphic printout Multichart. Five samples have been chosen.
2.4. Results

2.4.5 Calibration Results

The function field Results (Calibration) offers the possibility to call-up the results of the calibration samples. The window Overview Calibration results is divided into three sections: The lower section shows a list of the single parameters. Clicking on the parameter designations will cause an appearance of the fitting graphic in the upper section and of the statistic values in the middle section of the window.

The coloured belt shows the defined tolerances. This way, it can be seen immediately, whether a sample lies within the given ranges.

(For Information about definition and design of the window, see chapter Calibration Check)

![Overview Calibration Results](image)

The results can be printed for each parameter (graphic and statistics, function field Print). The function field Preview will show a print preview. Function field Open will open another results file.
2. OPERATION

Fig. 19: Printout Calibration Results (Parameter: Inner temperature = center temperature of the sample detected by the puncture needle directly after the test).
### 2.4.6 Results – Explanation

**Table 2: Explanation of the test results**

<table>
<thead>
<tr>
<th>Result</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test end at</td>
<td>Cause for the test end (break-down, normal test end, etc.)</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td></td>
</tr>
<tr>
<td>Initial gauge (h_0)</td>
<td>Sample height at the start of the test in mm <em>(measured with the height measurement station HMS)</em></td>
</tr>
<tr>
<td>Final gauge hot (h_e)</td>
<td>Sample height at test end in mm <em>(measured with the HMS)</em></td>
</tr>
<tr>
<td>Final gauge cold (h_x)</td>
<td>Sample height at end of the cooling time (x) in mm <em>(measured with the HMS)</em></td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
</tr>
<tr>
<td>Inner temperature</td>
<td><em>Center temperature.</em> Temperature in the center of the sample, measured by the puncture needle in °C</td>
</tr>
<tr>
<td>Room temp. start</td>
<td>Temperature in the temperature chamber in °C at the start of the test</td>
</tr>
<tr>
<td>Room temp. end</td>
<td>Temperature in the temperature chamber in °C at the end of the test</td>
</tr>
<tr>
<td>Contact temp. start</td>
<td>Temperature at the lower holder in °C at the start of the test</td>
</tr>
<tr>
<td>Contact temp. end</td>
<td>Temperature at the lower holder in °C at the end of the test</td>
</tr>
<tr>
<td>Delta T25</td>
<td>Temperature difference at the lower holder 25 minutes after the start of the test: [dT25 = T_{25min} - T_{start}] in °C</td>
</tr>
<tr>
<td>Delta T</td>
<td>Temperature difference at the lower holder at test end: [dT = T_{test\ end} - T_{start}] in °C</td>
</tr>
<tr>
<td><strong>Deformation</strong></td>
<td></td>
</tr>
<tr>
<td>Compression set hot</td>
<td>Deformation at the end of the test in %: [S_{\text{warm}} = 100 \times (h_0 - h_e) / h_0]</td>
</tr>
<tr>
<td>Compression set cold</td>
<td>Deformation at the end of the cooling time ‘(X)’ in %: [S_{\text{cold}} = 100 \times (h_0 - h_x) / h_0] (h_0) = Sample height before the test <em>(measured with the HMS)</em> (h_e) = Sample height after the test hot <em>(measured with the HMS)</em> (h_x) = Sample height after the cooling time <em>(measured with the HMS)</em></td>
</tr>
<tr>
<td>Static Compression</td>
<td>Static deformation of the sample in % <em>(measured in the test area under static load)</em></td>
</tr>
<tr>
<td>Initial flexing compression</td>
<td>Dynamic deformation after 5 seconds of testing time % <em>(measured in the test area under dynamic load)</em></td>
</tr>
<tr>
<td>Final flexing compression</td>
<td>Dynamic deformation at the end of the test % <em>(measured in the test area under dynamic load)</em></td>
</tr>
<tr>
<td>Compression set 1hr</td>
<td>Deformation 1 hour after test end <em>(optional, measured with the HMS)</em></td>
</tr>
<tr>
<td><strong>Others</strong></td>
<td></td>
</tr>
<tr>
<td>Fatigue life</td>
<td>Amount of cycles after test end</td>
</tr>
<tr>
<td>Creep</td>
<td>[F_1 = 100% \times (h_0 - h_T) / h_0] (h_0) = Sample height after 6 seconds of testing time <em>(deformation measured in the test area)</em> (h_T) = Sample height before the test <em>(measured with the HMS)</em></td>
</tr>
</tbody>
</table>
3. MAINTENANCE

3.1 Draining of the Compressed-air System

The compressed-air system of the Flexometer has equipment to separate the water from the compressed air. This equipment must be emptied regularly.

Empty the water separator once a week or on demand by pressing the water separator valve.

Fig. 20: Pneumatic control. 1=Pressure gauge system pressure (6bar); 2=pressure gauge MS (2bar), 3=compressed-air valve, 4=water separator, 5= valve of the water separator

3.2 Cleaning the Stations

In order to prevent the samples from sticking to the stations, the latter ones must be cleaned every 6 months. This concerns the following parts: upper and lower holder of the cooling stations, upper holder of the test area, the preheat station, the silos, the height measurement station.

The parts have to be cleaned with silicon oil. In case of the use of another mild cleaner, the parts must be covered with silicon oil or talcum powder.
3. MAINTENANCE

3.3 Changing the lower holder

Fig. 21: Test area with puncture needle. 1=puncture needle, 2=lower holder with manacle ring, 3=upper holder

1. Use pliers to press the end of the tension ring and draw off the holder together with the tension ring.
2. The holder has cable connections to a feeder box behind the temperature chamber. Loosen the binders inside the feeder box.
3. Connect the binders of the new holder inside the feeder box: **red to red, blue to blue**
4. Insert the holder and fix it with the tension ring.

3.4 Changing the puncture needle

**Note:** If it becomes necessary to the change of the puncture needle, ask your supervisor to do this.
4 ERRORS

Attention! Elimination of these failures by the SUPERVISOR ONLY!! Even the smallest mistake can DAMAGE THE HARDWARE!! If there are any doubts, call the Service!!

4.1 Failure in the sensor technology

A failure in the sensor technology of the Flexometer shows up in a wrong or even lacking signalling of positions of single hardware device, i.e. the limit switches do not or not correctly indicate the positions to the software: neither the LEDs at the limit switches nor the ones on the screen do lit at the right time.

Different reasons are possible for that, one of them may be the incorrect positioning of the limit switches. Therefore, the limit switches must be loosened and carefully moved in a manner, that they correctly indicate the stop position of the hardware device.

4.1.1 Example: Controlling the limit switches for the puncture needle

This control has already been described in chapter Setting the puncture depth of the puncture needle (Installation Manual).

Attention! The lower holder MUST be set to a deformation lower than 40%, otherwise the puncture needle will be damaged upon moving down!!

1. Open pneumatic valve and thereby, shut off the air pressure.

Attention! Press Emergency Stop!

2. Dismount the shell of the pneumatic thruster.

3. Control the lower limit switch by slowly moving down the needle with the linear guide. Adjust the limit switch, so that it definitely responds, when the needle is at the lower stop position (the LED of the limit switch as well as the screen LED Needle down in the window Manual Control have to lit).

4. Control the upper limit switch by slowly moving up the needle with the linear guide. Adjust the limit switch, so that it definitely responds, when the needle is at the upper stop position (the LED of the limit switch as well as the screen LED Needle up in the window Manual Control have to lit).

5. Re-mount the shell of the pneumatic thruster.

6. Close pneumatic valve and thereby, impinge the system with air pressure.